
This file is not meant for browsing

This file is not meant for browsing. It contains help and error messages.



Important 

Because of changes made to this version of Windows, the Calendar utility included with hDC First Apps may not 
function correctly. If you try to load the hDC Calendar utility, you will be able to see the calendar, but none of its 
features will be available.
If you are in the United States, call Express Systems at (206) 728-8300 for more information. If you are outside 
the United States, call the product support telephone number that came with your copy of hDC First Apps. Or, 
visit the Express Systems Web site at http://www.wrq.com.



Important

Stacker versions 4.0 or earlier do not support long file names. Do not use these versions of Stacker to compress, 
optimize, resize, uncompress, or change the expected compression ratio of a drive that has long file names. If 
you do, you will truncate long file names to eight-character names with three-character extensions. In addition, 
Stacker versions 4.1 and earlier are unable to compress drives that use large disk support (FAT32).
For further information, refer to the Stac Web site at http://www.stac.com.



Important 

Because of changes made to this version of Windows, this version of Do It On Your Desktop does not run 
correctly. If you try to start Do It On Your Desktop, the program will stop running.
If you are in the United States, call Moon Valley Software at (800) 473-5509 for information about obtaining an 
upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your copy of Do It On Your Desktop. Or, visit Moon Valley Software’s Web sit at 
http://www.moonvalley.com.



Important 

Because of changes made to this version of Windows, some features of Lotus ScreenCam versions 2.0 and earlier
do not function correctly. ScreenCam 2.0 plays Windows 3.1 screen movies under this version of Windows but 
does not record screen activity. 
If you are in the United States, call Lotus at (800) 343-5414 for information about obtaining an upgraded version 
of this program. If you are outside the United States, call the product support telephone number that came with 
your copy of ScreenCam. Or, visit the Lotus Web site at http://www.lotus.com.



Important 

Because of changes made to this version of Windows, this version of Peachtree Accounting may not run correctly.
If you are in the United States, call (800) 336-1420 for information about obtaining an upgraded version of this 
program. If you are outside the United States, call the product support telephone number that came with your 
copy of Peachtree Accounting. Or, visit the Peachtree Web site at http://www.peachtree.com.



Important 
Because of changes made to this version of Windows, Adobe Photoshop version 3.0 may not run correctly. 
Changing default settings in common dialog boxes may result in problems. For example, in the Open dialog box, 
you may encounter problems if you change the setting in List Files Of Format Type.
For information about obtaining an upgraded version of this program, contact Adobe at (800) 872-3623. If you 
are outside the United States, contact your local Adobe distributor or authorized reseller. Or, visit the Adobe Web 
site at http://www.adobe.com.



Important 
Because of changes made to this version of Windows, this version of Crystal Walls may not run correctly. If you 
run Crystal Walls, you will be able to see pictures, but they will not be animated. 
Call the product support telephone number that came with your copy of Crystal Walls for information about 
obtaining an upgraded version of the program. 



Important 
This disk utility was written for Windows 3.1. Some of this utility's features may not function correctly under this 
version of Windows.
For information about obtaining upgraded disk utilities written for this version of Windows, contact the 
manufacturer of this utility or your software vendor. 



Important 
This virus protection utility was written for Windows 3.1. Some of this utility's features may not function correctly
under this version of Windows. You will be able to detect viruses, but not clean them. This utility may also detect 
virus activity where none occurs.
For information about virus utilities that were written for this version of Windows, contact the manufacturer of 
this program or your software vendor. 



Important 
If you are using the Access Developer's Toolkit version 2.0 to create setup disks that will be used under Windows 
3.1, you must create those disks while running Windows 3.1.
If you create setup disks while running this version of Windows, those disks will contain system components from
this version. If those setup disks are used on a Windows 3.1 system, the Windows 3.1 files will be replaced, 
causing serious problems.
If anyone using your program will be running Windows 3.1, create the setup disks while running Windows 3.1. 



Important 
If you are using the Visual Basic Setup Toolkit version 3.0 to create setup disks that will be used under Windows 
3.1, you must create those disks while running Windows 3.1.
If you create setup disks while running this version of Windows, those disks will contain system components from
this version. If those setup disks are used on a Windows 3.1 system, the Windows 3.1 files will be replaced, 
causing serious problems.
If anyone using your program will be running Windows 3.1, create the setup disks while running Windows 3.1. 



Important 
If you run the Aris MPC Wizard under this version of Windows using a color palette higher than 256 colors, the 
program may stop running. 
For information about setting your palette, click Start, click Help, and then on the Index tab, type palette.



Important 
Some Windows 3.1 user interface replacements may not function correctly under this version of Windows. 
Running a Windows 3.1 user interface replacement with this version of Windows causes some features of the 
interface to be unusable.
For more information about this replacement interface, contact the manufacturer or your software vendor. 



Important 
This program was designed to run only on Windows NT. It takes advantage of high-end Windows NT interfaces or 
features that are not available in this version of Windows.
For information about a version of this program that is designed for this version of Windows, contact the 
program's manufacturer or your software vendor. 



Important 
Do not run the Microsoft Sound System version 2.0 setup program under this version of Windows. Instead, set up
the Microsoft Sound System hardware by carrying out the following procedure.

To set up Microsoft Sound System hardware under this version of Windows

1 Click Start, point to Settings, and then click Control Panel. 
2 Click Add New Hardware. 
3 Install your sound card by following the instructions on your screen.



Important 
This version of TabWorks may need to be upgraded to function correctly under this version of Windows.
Although you can run your current version of TabWorks under this version of Windows, it is recommended that 
you do not use it as your default interface. Instead, follow this procedure to start TabWorks.

Click Start, point to Programs, and then click TabWorks. 
You will be able to use all of the items currently in your TabWorks book, but you will be unable to add a new item 
to your book by using File Tracking or by dragging the item.
If you are in the United States, contact XSoft at (800) 909-4446 for information about obtaining an upgraded 
version of this program. If you are outside the United States, call the product support telephone number that 
came with your copy of TabWorks. Or, visit the Xsoft Web site at http://www.xsoft.com.



Important 
Because of changes made to this version of Windows, the tutorial for PFS: Window Works may not run correctly if
your taskbar setting is Always On Top. If you try to run the tutorial with the taskbar on top, the program may 
stop responding. To resolve this problem, change the taskbar setting before running the tutorial.

To change your taskbar setting
1 Click Start, point to Settings, and then click Taskbar & Start Menu.
2 Clear the Always On Top check box. 



Important 
The MaxTime, FN-esse, and Toshiba sound control programs that were written for Windows 3.1 prevent the 
taskbar in this version of Windows from correctly displaying buttons that represent running programs. If you 
decide to use any of these programs, buttons on the taskbar representing running programs will not function 
correctly. To switch between open programs, press ALT+TAB.
If you are in the United States, call your local Toshiba product support organization for more information, or call 
(800) 999-4273. If you are outside the United States, call the product support telephone number that came with 
your copy of this program. Or, visit the Toshiba Web site at http://www.toshiba.com.



Important
Because of changes made to this version of Windows, some features of this version of Central Point Anti-Virus do 
not function correctly. 
If you are in the United States, contact Symantec Corporation at (800) 441-7234 for information about obtaining 
an upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your copy of this program. Or, visit the Symantec Web site at http://www.symantec.com.



Important 
Because of changes made to this version of Windows, Family Tree Maker version 2.0 may not run correctly if your
taskbar setting is Always On Top. If you try to run Family Tree Maker with the taskbar on top, the program may 
stop responding. To resolve this problem, change the setting before running the program.

To change your taskbar setting 
1 Click Start, point to Settings, and then click Taskbar & Start Menu.
2 Clear the Always On Top check box.
If you are in the United States, contact Banner Blue Software at (510) 794-6850 for information about obtaining 
an upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your copy of this program. Or, visit the Banner Blue Software Web site at 
http://www.broderbund.com.



Important 
Because of changes made to this version of Windows, TrueEffects may not function correctly.
If you are in the United States, contact Mindscape Direct at (510) 652-5464 for more information. If you are 
outside the United States, call the product support telephone number that came with your copy of TrueEffects. 
Or, visit the Mindscape Web site at http://www.mindscape.com.



Important 
Because of changes made to this version of Windows, this version of NCD PC-Xware may not function correctly. If 
you install PC-Xware on a computer that is running this version of Windows, your computer may not start.
If you are in the United States, contact NCD at (800) 548-8871 for more information. If you are outside the 
United States, call the product support telephone number that came with your copy of this program. Or, visit the 
ON Technology Web site at http://www.elronsw.com.



Important
Because of changes made to this version of Windows, Wired for Sound version 1.0 does not function correctly.
If you are in the United States, contact Aristo-Soft, Inc. for more information.

To contact by Do the following
Fax Send name and address to (510) 328-1117
E-mail Send questions to wfs@pacbell.net
World Wide 
Web

http://www.aristosoft.com

If you are outside the United States, call the product support telephone number that came with your copy of 
Wired for Sound. 



Important 
Because of changes made to this version of Windows, older versions of Icon Hear It may not run. When you try to
close older versions of Icon Hear It, the program may stop running. 
If you are in the United States, call Moon Valley Software at (800) 473-5509 or (805) 781-3890, or send a fax to 
(805) 781-3898, for information about obtaining an upgraded version of this program. If you are outside the 
United States, call the product support telephone number that came with your copy of Icon Hear it. Or, visit 
Moon Valley Software’s Web site at http://www.moonvalley.com.



Important 
If you are running DaVinci eMAIL and you use a network printer, make sure the network path is associated with a
printer port (this is also referred to as capturing a printer port). Otherwise, you may encounter problems when 
you print to a network printer.
Click here        for information about capturing a printer port.

If you are running DaVinci eMAIL version 3.0, you cannot add user licenses in this version of Windows. To add new 
users, you need DaVinci eMAIL version 3.1.

If you are in the United States, call ON Technology Corporation at (800) 548-8871, or send a fax to (617) 692-
3539, for more information. If you are outside the United States, call the product support telephone number that 
came with your copy of DaVinci eMAIL. Or, visit the ON Technology Web site at http://www.elronsw.com.



Important 
The 16-bit version of the Windows NT management tools does not run under this version of Windows. To resolve 
this problem, use the 32-bit version of these tools, which is located on The Microsoft Network.



Important 
If you installed Microsoft Exchange, which is included with this version of Windows, you will be unable to run 
older versions of Microsoft Mail. When you install Microsoft Exchange, some Microsoft Mail files get replaced. 
Older versions of Microsoft Mail cannot use the new versions of these files. 



Important 
Because of changes made to this version of Windows, Nickelodeon Director's Lab may display some error 
messages at the end of its setup program. If this occurs, you must close the setup program manually.
After the setup program has added new shortcuts, you may see a message that says, "Setup Message: Script or 
DLL has been corrupted. Unable to load dialog template: 'mscuistf.dll: 2'." If this message appears, carry out the 
following procedure.

To close the Nickelodeon Director's Lab setup program
1 Press CTRL+ALT+DEL.
2 In the Close Program dialog box, click Director's Lab setup program, and then click End Task.

This ends the error messages and closes the setup program. 



Important 
The WorldView CD-ROM by Aris Entertainment includes a modified version of Microsoft Video for Windows. 
Because this modified version was not configured properly, it may erroneously report that a device driver is 
corrupted and may advise you to call product support services.
If you are following the instructions in the Readwrld.txt file, you may see an error message on your screen 
indicating that the source file or destination disk may be corrupted. If you receive such an error message, carry 
out the following procedure.

To fix this problem

1 Click Start, and then click Run.
2 In Open, type: command /c copy x:\vfwsetup\iccvid.drv %windir%\system /y 

where x is the letter of your CD-ROM drive.
3 Click OK.
4 Reinstall Microsoft Video for Windows by following the instructions in the Readwrld.txt file.



Important 
Because of changes made to this version of Windows, Turbo Debugger version 3.1 for Windows may not run 
correctly.
If you are in the United States, contact Borland International, Inc. for information about obtaining an upgraded 
version of this program. To place an order, call (800) 331-0877. For technical support, call (408) 461-9177. If you 
are outside the United States, call the product support telephone number that came with your copy of Turbo 
Debugger. Or, visit the Borland Web site at http://www.borland.com.



Important 
Older versions of PrintCache were designed to modify parts of Windows 3.1 printer drivers. If you run older 
versions of PrintCache under this version of Windows, none of the printer drivers installed on your computer will 
work.
For more information about this program, contact your software vendor.



Important 
If you use a network printer, make sure the network path is associated with a printer port (this is also referred to 
as capturing a printer port). Otherwise, you may encounter problems when you print to a network printer from 
this program.
Click here        for information about capturing a printer port.

For more information about this program, contact the manufacturer or your software vendor.



Important 
Because of changes made to this version of Windows, this version of pcAnywhere may not function correctly.
If you are in the United States, contact Symantec Corporation at (800) 441-7234 for information about obtaining 
an upgraded version of pcAnywhere. If you are outside the United States, call the product support telephone 
number that came with your copy of pcAnywhere. Or, visit the Symantec Web site at http://www.symantec.com.



To capture a printer port
1 Click here        to open the Printers folder.

2 Point to the icon for the printer you are using.
3 On the File menu, click Properties.
4 Click the Details tab. 
5 In Print to the following port, click the port specified.

If the specified port begins with the letters LPT, the port has been captured. Close the Properties dialog box. 
If the specified port begins with backslashes (\\), write down the text that appears in Print to the following 
port, and then click Capture Printer Port. 

6 In Device, click a printer port that you are not already using.
7 In Path, type the text you wrote down in step 5.
8 Select the Reconnect at logon check box if you want to permanently capture this printer port, and then click 

OK.
9 In Print to the following port, click the port you chose in step 6, and then click OK.

Note
For Help on an item, click    

    at the top of the dialog box, and then click the item.



Important
Because of changes made to this version of Windows, Thumbelina may not install correctly. You can resolve this 
problem by adding a line to your System.ini file. This line tells the setup program that this version of Windows is 
Windows version 3.1.

To enable Thumbelina Setup to run

1 Print or write down these instructions.
2 Click here        to start System Configuration Editor.

3 On the Window menu, click the Win.ini file.
4 In the [Compatibility] section, type the following text on a line of its own:

DSHELL=0x00200000
5 On the File menu, click Exit.
6 To save your changes to the Win.ini file, click Yes.
7 Restart your computer, and then run the Thumbelina Setup program.
8 After Thumbelina is installed, carry out steps 2 through 6 again, but for step 4, remove the text that you added

to the Win.ini file. 



Important 
Because of changes made to this version of Windows, if you switch between standard and enhanced 
environments in MCS Stereo version 1.05, the mixer controls will be disabled. To enable them, close the program,
and then reopen it. 
If you are in the United States, contact Animotion Development Corp. for information about obtaining an 
upgraded version of this program. You can reach the company at the following numbers: telephone (205) 591-
5715; fax (205) 591-5716; and technical support BBS (205) 591-5795. If you are outside the United States, call 
the product support telephone number that came with your copy of MCS Stereo. 



Important 
The McAfee network management software NetTools versions 5.1 and 5.2 contain the program Appman.exe, 
which is a replacement for Windows 3.1 Program Manager. Appman.exe may not function correctly under this 
version of Windows.
If you are in the United States, contact McAfee Associates, Inc. for information about obtaining an upgraded 
version of this program. You can reach the company at the following numbers: telephone (408) 988-3832; fax 
(408) 970-9727; and technical support BBS (408) 988-4004. If you are outside the United States, call the product
support telephone number that came with your copy of NetTools. Or, visit the McAfee Web site at 
http://www.mcafee.com.



Important 
Because of changes made to this version of Windows, running Adobe Acrobat version 1.0 may create a general 
protection fault error. If this occurs, upgrade to the latest version of Acrobat. 
If you are in the United States, call (800) 872-3623 for information about obtaining an upgraded version of 
Acrobat. If you are outside the United States, call the Adobe product support telephone number that came with 
your copy of Acrobat. Or, visit the Adobe Web site at http://www.adobe.com.



Important 
Because of changes made to this version of Windows, the device-disabling feature included in the Compaq utility
Secure may not function correctly. For secure device disabling, run Compaq F10 Setup in conjunction with the 
setup password. You can also disable a device by carrying out the following procedure.

To disable a hardware device

1 Click here        to open the System Properties dialog box.
2 Click the plus (+) sign beside the hardware type, and then double-click the hardware.
3 In the Device Usage area, select the Disable in This Hardware Profile check box.

If there is more than one configuration listed in the Device Usage area, select the configuration check boxes 
for the devices you want to disable.

Note
After the device is disabled, the resource settings may not be free unless you have Plug and Play hardware.



Important 
Because of changes made to this version of Windows, RemindMe version 1.0 may not run.
Call the product support telephone number that came with your copy of RemindMe for information about 
obtaining an upgraded version of the program.



Important
This program was designed for Windows 3.1. Because of changes made to this version of Windows, some of the 
program's features, such as the floppy RPM test, RAM test, and video tests, do not function correctly.
If you are in the United States, contact Quarterdeck Select for information about obtaining a version of this 
program that is designed for this version of Windows. 

To contact by Do the following
Telephone Call (800) 354-3222

Call (573) 875-0932 (Technical Support)
Fax Send questions to (813) 523-2335
Web site Connect to http://www.quarterdeck.com 

If you are outside the United States, call the product support telephone number that came with your copy of this 
program.



Important 
Because of changes made to this version of Windows, Pixar's Typestry may not run. To fix this problem, create a 
Win32s.ini file for it, and then save it in your System folder.

To create a Win32s.ini file
1 Click here        to start Notepad.

2 In Notepad, type the following:
[WIN32s]
Version=1.3

3 On the File menu, click Save.
4 Name the file Win32s.ini, and save it in the System folder, which is located in the folder that contains your 

Windows files.
If you are in the United States, contact Pixar Animotion Studios for more information about this program. You can
reach the company at the following numbers: telephone (800) 888-9856 or (510) 236-4000; fax (510) 236-0388; 
and technical support telephone (800) 937-3179. If you are outside the United States, call the product support 
telephone number that came with your copy of Typestry. Or, visit the Pixar Web site at http://www.pixar.com.



Important 
Because of changes made to this version of Windows, SpaceManager version 1.53 or earlier may not run 
correctly. Although you can install SpaceManager in MS-DOS mode, most of the program's utilities will not 
function correctly.
Because SpaceManager is no longer manufactured, it is recommended that you obtain a similar program that 
was designed for this version of Windows.



Important 
You must install or run this game from the MS-DOS command prompt. If you attempt to run or install it by 
clicking Start, and then clicking Run, the game will not install or run correctly.

To run this game

1 Click Start, point to Programs, and then click MS-DOS Prompt.
2 Type the command that installs or runs the game.



Important 
Super PC-Kwik version 4.0 does not run correctly under this version of Windows. The program can cause 
irreparable problems on hard disks that were compressed by using DoubleSpace. 
It is recommended that you do not install Super PC-Kwik version 4.0 under this version of Windows.
If you are in the United States, call MicroDesign International at (800) 228-0891, or send a fax to (407) 677-8365,
for more information about this program. If you are outside the United States, call the product support telephone
number that came with your copy of Super PC-Kwik. Or, visit the MicroDesign Web site at http://www.mdi.com.



Important

This version of PC Tools was designed to work with MS-DOS or Windows 3.1. Some of this program's features do 
not function correctly under this version of Windows. If you are using large disk support (FAT32), this program 
may not run.
If you are in the United States, contact Symantec Corporation for information about obtaining new disk utilities 
that were designed for this version of Windows. You can reach the company at (800) 441-7234. If you are outside
the United States, call the product support telephone number that came with your copy of PC Tools. Or, visit the 
Symantec Web site at http://www.symantec.com.



Important 
You can install this version of Windows on existing SuperStor compressed drives and existing compressed 
volume files. However, because of incompatibilities, you cannot compress drives using SuperStor after you install
this version of Windows. 
SuperStor/DS uses a file named Defrag.exe to compress a drive. That file is replaced with a newer version during
Windows Setup, and SuperStor cannot use the newer version of the file.
There are no known versions of SuperStor available for this version of Windows. If you want to compress a new 
drive or create a new compressed volume file, obtain a compression program that was designed for this version 
of Windows.



Important 
DoubleTools for DoubleSpace by Addstor is incompatible with this version of Windows. Do not install this program
under this version of Windows. If you do, you will lose access to any existing compressed volume files when you 
restart your computer.



Important 
Because of changes made to this version of Windows, Carbon Copy version 2.5 and earlier does not run. If you 
attempt to run either the host or guest components of Carbon Copy, your computer will stop responding. 
If you are in the United States, contact Microcom for information about obtaining an upgraded version of this 
program. You can contact the company in the following ways: call (800) 822-8224; send a fax to (617) 551-1021;
call technical support BBS (617) 762-5134; or connect to their Web site at http://www.microcom.com. If you are 
outside the United States, call the product support telephone number that came with your copy of Carbon Copy.



Important 
Because of changes made to this version of Windows, this version of your Cyberflix product may not run. 
For information about obtaining an upgraded version of this program, visit the Cyberflix Web site at 
http://www.cyberflix.com or call the product support telephone number that came with your Cyberflix product.



Important 
Because of changes made to this version of Windows, Adobe Illustrator version 4.0 may not run. If you receive a 
general protection fault error while trying to run this program, you may be able to resolve the problem by using 
the standard VGA display drivers that came with this version of Windows. If your display is already set for 
standard VGA, click the Run Program button.
Click here        for information about changing display drivers.
If you are in the United States, contact Adobe at (800) 872-3623 for information about obtaining an upgraded 
version of this program. If you are outside the United States, call the product support telephone number that 
came with your copy of Adobe Illustrator. Or, visit the Adobe Web site at http://www.adobe.com.



To change your display driver

1 Click here        to open the Display Properties dialog box at the Settings tab.
2 Click Advanced.
3 Click the Adapter tab, and then click Change.
4 Follow the instructions on your screen.



Important 
This version of Windows does not support the program icons installed by the setup program for EarthCare! 
Although the setup program runs successfully, no icons are created. You can either run EarthCare! by using the 
Run command or by creating an EarthCare! submenu on the Programs menu, and then adding icons to the 
submenu.
            To run EarthCare! by using the Run command  
            To create a submenu and icons for EarthCare!  



To run EarthCare! by using the Run command

1 Click Start, and then click Run. 
2 In the Open box, type the following:

x:\pc\earthc.exe
where x is the letter of your CD-ROM drive.



To create a submenu and icons for EarthCare!

1 Right-click Start, and then click Open.
2 Point to the Programs folder.
3 On the File menu, point to New, and then click Folder.
4 Type the following name for the folder:

EarthCare!
5 Press ENTER, and then click the folder you just created. 
6 On the File menu, point to New, and then click Shortcut.
7 Use the Create Shortcut wizard eight times to create a shortcut for each the following items. For the letter x, 

substitute the letter of your CD-ROM drive.
Command line Shortcut name
x:\pc\earthc.exe EarthCare!
X:\pc\
read_me.wri

Read Me

x:\pc\register.wri Register!
X:\pc\iloveair.wri I Love Air text
x:\pc\iloveani.wri I Love Animals text
x:\pc\ilovedrt.wri I Love Dirt text
x:\pc\ilovewtr.wri I Love Water text
x:\pc\songs.wri Words to the songs

8 To start an EarthCare! program, click Start, point to Programs, and then point to EarthCare!



Important 
If you use a network printer with 3D Home Architect under this version of Windows, make sure the network path 
is associated with a printer port (this is also referred to as capturing a printer port). Otherwise, you may 
encounter problems when printing to a network printer. 
Click here        for information about capturing a printer port.

If you are in the United States, contact Broderbund Software, Inc. at (800) 521-6263 for information about obtaining
an upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your current copy of 3D Home Architect. Or, visit the Broderbund Web site at 
http://www.broderbund.com.



To install additional fonts from Microsoft TrueType Font Pack
For information about adding fonts, click Start, click Help, and then on the Index tab, type fonts.



Important 
Because of changes made to this version of Windows, some of the features of this version of Symantec's Time 
Line may not work correctly. If you attempt to use the Tools.run macro and Time Line samples, Time Line will stop
responding.
If you are in the United States, contact TimeLine Solutions Corporation at (415) 898-1919 for information about 
obtaining an upgraded version of this program. If you are outside the United States, call the product support 
telephone number that came with your copy of Time Line. Or, visit the TimeLine Web site at 
http://www.tlsolutions.com.



Important 
Because of changes made to this version of Windows, some features of Close-Up version 6.0 or Close-Up/LAN Pro
version 6.1 may not function correctly. The Remote side of Close-Up is currently compatible with this version of 
Windows.
If you are in the United States, contact Norton-Lambert Corp. for information about obtaining a version of Close-
Up that was designed for this version of Windows. You can reach Norton-Lambert in the following ways: 
telephone (805) 964-6767 extension 1; fax (805) 683-5679; or by visiting their Web site at http://www.norton-
lambert.com. If you are outside the United States, call the product support telephone number that came with 
your current copy of Close-Up.



Important 
Do not run the setup program for this version of your Humongous Entertainment program. Because of changes 
made to this version of Windows, installing this program on your computer may result in system errors. You can, 
however, run the program from your CD-ROM by locating either the Autofred.exe or Autofarm.exe file, double-
clicking it, and then clicking Play. You can add a command to start this program to the Start menu or Programs
menu. 
For information about adding a command to the Start or Programs menu, click Start, click Help, and then on 
the Index tab, type Start menu or Programs menu.
If you are in the United States, contact Humongous Entertainment at (425) 485-1212 for more information. If you
are outside the United States, call the product support telephone number that came with your Humongous 
Entertainment program. Or, visit the Humongous Web site at http://www.humongous.com.



Important 
Because of changes made to this version of Windows, Symantec C++ Professional version 6.1 and earlier do not 
function correctly.
If you are in the United States, contact Symantec at (800) 441-7234 for information about obtaining an upgraded
version of this program. If you are outside the United States, call the product support telephone number that 
came with your copy of Symantec C++ Professional. Or, visit the Symantec Web site at 
http://www.symantec.com.



Important 
Because of changes made to this version of Windows, Upfront version 1.1 may not run. 
If you are in the United States, contact SketchTech at (612) 379-1435 for more information about this program. If 
you are outside the United States, call the product support telephone number that came with your copy of 
Upfront.



Important
Because of changes made to the display drivers for this version of Windows, Proxy does not work. 
If you are in the United States, contact Funk Software, Inc. for information about a version of this program that 
was designed for this version of Windows. 

To contact by Do the following
Telephone Call (800) 828-4146
Fax Send questions to (617) 547-

1031
E-mail Send to sales@funk.com
Web site Connect to 

http://www.funk.com
If you are outside the United States, call (617) 497-6339.



Important
Because of changes made to this version of Windows, the WanderLink component named Proxy does not run. 
During WanderLink Client installation, make sure you do not install the Proxy Master or Host components.
If you are in the United States, contact Funk Software, Inc. for information about a version of this program that 
was designed for this version of Windows. 

To contact by Do the following
Telephone Call (800) 828-4146
Fax Send questions to (617) 547-

1031
E-mail Send to sales@funk.com
Web site Connect to 

http://www.funk.com
If you are outside the United States, call (617) 497-6339.



Important
Because of enhancements to the graphics drivers in this version of Windows, Poetry in Motion does not run 
correctly if your screen is set to a resolution other than 640 by 480 pixels. 
For information about changing your screen resolution, click Start, click Help, and then on the Index tab, type 
resolution.
If you are in the United States, call the Voyager Co. at (800) 446-2001 for more information about this program. 
If you are outside the United States, call the product support telephone number that came with your copy of 
Poetry in Motion. Or, visit the Voyager Web site at http://www.voyagerco.com.



Important 
Because of changes made to this version of Windows, certain features of this version of Wired for Sound Pro may
not work correctly. 
Contact one of the following services for information about obtaining an upgrade of Wired for Sound that is 
compatible with this version of Windows.

To contact by Do the following
Web site Connect to 

http://www.aristosoft.com
E-mail Send to wfs@pacbell.net
Fax Send to (510) 328-1117

If you are outside the United States, call the product support telephone number that came with your copy of 
Wired for Sound Pro.



Important 
When you use a network printer with PerForm PRO, make sure the network path is associated with a printer port 
(this is also referred to as capturing a printer port). Otherwise, you may encounter problems when printing to a 
network printer.
Click here        for information about capturing a printer port.

If you are in the United States and want more information about PerForm PRO, call Symantec at (800) 441-7234; 
send a fax to (541) 984-2490; or connect to Symantec’s Web site at http://www.symantec.com. If you are outside 
the United States, call the product support telephone number that came with your copy of PerForm PRO.



Important 
Because of changes made to this version of Windows, Remotely Possible/Sockets version 1.1 does not run.
If you are in the United States, contact Avalan Technology, Inc. at (800) 441-2281 or (508) 429-6482 for 
information about obtaining an upgraded version of this program. Or, see Avalan Technology’s Web site at 
http://www.avalan.com. If you are outside the United States, call the product support telephone number that 
came with your copy of this program.



Important 
To install this Lotus product from a computer that is on a network, you need to map a drive letter to the network 
computer.
For information about mapping a drive letter to a network computer, click Start, click Help, and then on the 
Index tab, type drive letters.
If you are in the United States, contact the word processing division of Lotus Development Corp. for information 
about obtaining the latest version of Ami Pro or Word Pro. You can telephone the company at (800) 343-5414, or 
visit their Web site at http://www.lotus.com. If you are outside the United States, call the product support 
telephone number that came with your copy of this program.



Important

Stacker versions 4.1 and earlier are unable to compress drives that use large disk support (FAT32).
For further information, refer to the Stac Web site at http://www.stac.com.



Important

Do not use Stacker versions 4.0 or earlier to compress drives that have long file names. If you do, you will 
truncate long file names to eight-character names with three-character extensions. In addition, Stacker versions 
4.1 and earlier are unable to compress drives that use large disk support (FAT32).
For further information, refer to the Stac Web site at http://www.stac.com



Important 
Because of changes made to this version of Windows, versions 2.0 and 2.2 of the Bounds Checker program by 
NuMega do not work. 
If you are in the United States, call NuMega at (800) 468-6342 for information about obtaining an upgraded 
version of this program. If you are outside the United States, call the product support telephone number that 
came with your copy of Bounds Checker. Or, visit the NuMega Web site at http://www.numega.com.



Important 
If you are installing ClarisWorks version 2.0, continue with the installation. If you are installing ClarisWorks 
version 1.0 for Windows, you cannot install the program by using Setup.exe, which is located on disk one. Use 
Setupcw.exe, which is located on disk two, instead. 
If you are in the United States, contact Claris Corp. for information about obtaining a version of this program that
was designed for this version of Windows. You can reach the company at the Voice Answerline at (800) 735-
7393, the Fax Answerline at (800) 800-8954, or by visiting their Web site at http://www.claris.com. 
If you are outside the United States, call the product support telephone number that came with your copy of 
ClarisWorks. 



Important 
Because of changes made to this version of Windows, this version of Norton AntiVirus may not function correctly.
If you are in the United States, contact Symantec Corporation at (800) 441-7234 for information about obtaining 
an upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your copy of Norton Antivirus. Or, visit the Symantec Web site at 
http://www.symantec.com.



Important 
Because of changes made to this version of Windows, this version of Norton Desktop or Norton Backup for 
Windows may not function correctly or may not run.
If you are in the United States, contact Symantec Corporation at (800) 441-7234 for information about utilities 
designed specifically for this version of Windows. If you are outside the United States, call the product support 
telephone number that came with your copy of Norton Desktop for Windows. Or, visit the Symantec Web site at 
http://www.symantec.com.



Important 
Because of changes made to this version of Windows, this version of Norton Utilities may not function correctly.
If you are in the United States, contact Symantec Corporation at (800) 441-7234 for information about obtaining 
an upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your copy of Norton Utilities. Or, visit the Symantec Web site at 
http://www.symantec.com.



Important 
Because of changes made to this version of Windows, this version of Norton Commander may not function 
correctly. 
If you are in the United States, contact Symantec Corporation at (800) 441-7234 for information about obtaining 
an upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your copy of Norton Commander. http://www.symantec.com.



Important 
This program was designed for an earlier version of Windows. Because of changes made to this version of 
Windows, it does not work correctly. If you try to run this program anyway, make sure you first save any work in 
other running programs.
For more information about this program, contact its manufacturer or your software vendor. 



Important 
This program may not print correctly under this version of Windows.
For more information about this program, contact its manufacturer or your software vendor.



Important 
This program may not work correctly under this version of Windows.
For more information about this program, contact its manufacturer or your software vendor.



Important 
You may be unable to run this program under this version of Windows using certain display settings. If you 
encounter problems, change the number of colors your monitor displays to 256 or 16 colors.
For information about changing your palette, click Start, click Help, and then on the Index tab, type palette.
If problems persist, contact the program's manufacturer or your software vendor.



Important 
You may be unable to run this program under this version of Windows using certain display settings. If you 
encounter problems, change your screen resolution to 640 by 480 pixels.
For information about changing your screen resolution, click Start, click Help, and then on the Index tab, type 
resolution.
If problems persist, contact the program's manufacturer or your software vendor.



Important 
Because of the advanced 32-bit networking features in this version of Windows, this program may not work 
properly. If you need to continue to use this program, use the networking software that was on your computer 
before you installed Windows. For more information, contact your network administrator.
For more information about this program, contact its manufacturer or your software vendor.



Important 
This version of Windows is capable of detecting many types of hardware. To ensure that your hardware is 
properly set up, use the Add New Hardware wizard to install the drivers for it.
For information about setting up new hardware, click Start, click Help, and then on the Index tab, type 
hardware.



Important 
Do not change the settings for your hardware by using the Control Panel program that came with it. Instead, 
carry out the following procedure.

To change the settings for your hardware

1 Click Start, point to Settings, and then click Control Panel.
2 Click the icon for the hardware you want to change. 

If there is no icon for your hardware, click System.
3 Change settings as needed. 

Note
For Help on an item, click    

    at the top of the dialog box, and then click the item.



Important 
For information about running this program under this version of Windows, see the Readme.txt file.

To locate and open the Readme.txt file

1 Click Start, point to Find, and then click Files or Folders.
2 In the Named box, type the following:

readme.txt
3 In Look in, select the drive where Windows is installed (usually C:).
4 Click Find Now.

Windows may locate several Readme.txt files.
5 Click the Readme.txt file that is located in the folder that contains your Windows files.
6 Search the file for the name of this program.



Important 
This MS-DOS program runs correctly under this version of Windows on most computers. If it does not run 
correctly on your computer, you may need to run it in MS-DOS mode. MS-DOS mode removes Windows from 
memory and creates an MS-DOS environment.

To run this program in MS-DOS mode

1 Quit the program if it is running, and then use My Computer to locate the program's icon.
2 Right-click the program's icon, and then click Properties.
3 Click the Program tab, and then click Advanced.
4 Select the MS-DOS Mode check box.
5 Click OK in all open dialog boxes, and then restart the program.



Important 
Running this program under this version of Windows may cause Windows to become unstable or may prevent 
Windows from starting correctly. It is recommended that you do not run this program under this version of 
Windows.
For more information about this program, contact its manufacturer or your software vendor.



Important 
This version of Windows allows longer printer names than earlier versions of Windows. Because of this, it is 
possible to create printer names that your existing programs cannot recognize.
If you have problems printing to a network printer whose name is longer than 14 characters, you can either ask 
your network administrator to rename it, or you can capture the printer port.
Click here        for information about capturing a printer port.



Important
This MS-DOS program requires expanded (EMS) memory to function correctly. If you are using a memory 
manager such as QEMM or 386Max, check the documentation that came with the memory manager for 
information about how to provide EMS memory. If you are using EMM386, carry out the following procedure.

To make sure Emm386.exe is providing expanded memory
1 Click here        to start System Configuration Editor.

2 On the Window menu, click CONFIG.SYS.
3 In the CONFIG.SYS window, if no lines contain EMM386.EXE, type the following as the first line:

Device=c:\Windows\Himem.sys
For the second line, type:
Device=c:\Windows\Emm386.exe
If either Himem.sys or Emm386.exe is located in a different folder, replace c:\Windows with the path to the 
file.
If there is already an existing line that contains EMM386.EXE, make sure that NOEMS is not included on that 
line. If NOEMS is included, remove only the NOEMS statement and leave the rest of the line as it is.

4 On the File menu, click Exit.
5 Click Yes to save your changes.
6 Restart your computer. 

EMS memory should now be available to your program.



Important 
Do not install this printer driver under this version of Windows. Either obtain an upgraded driver from the 
manufacturer of your printer, or install the driver that comes with this version of Windows. To install the driver 
that comes with this version of Windows, carry out the following procedure.

To install printer drivers for this version of Windows

1 Click Start, point to Settings, and then click Printers.
2 Click Add Printer.
3 Follow the instructions on your screen.



Important 
Because of changes made to this version of Windows, you cannot install Famous Places by using Setup.exe. 
Instead, use Fpsetup.exe, which is located in the same folder. The Fpsetup.exe program may not copy some of 
the necessary drivers because of changes in Video for Windows device drivers. To resolve this problem, carry out
the following procedure before you start Famous Places.

To copy the necessary components

1 Print or write down these instructions.
2 Finish the Famous Places setup program, and then carry out the following steps.
3 Click Start, and then click Run.
4 In the Open box, type the following:

command /c copy x:\indeo.drv %windir%\system /y
where x is the letter of your CD-ROM drive.

5 Click OK. 
Famous Places should now function correctly.



Important 
The Star Trek Interactive Technical Manual installs its animation components on your hard disk in a folder named 
Windows. If the folder that contains your files for this version of Windows is not named Windows, the animation 
components may not function correctly. To resolve this problem, carry out the following procedure.

To copy Star Trek animation components 

1 Print or write down these instructions.
2 Click the Run Program button, and then finish the Star Trek Interactive Technical Manual setup program.
3 When the setup program is complete, click Start, and then click Run.
4 In Open, type the following:

command /c copy x:\qtw\*.* %windir%\system /y
where x is the letter of your CD-ROM drive.

5 Click OK.
6 Restart your computer. 



Important 
Because of changes made to this version of Windows, you need to add a line to your System.ini file before 
running this program. Write down the following instructions, or print them by clicking the Print button in this 
topic. After the setup program is complete, carry out the following procedure.

To modify your System.ini file
1 Click here        to start System Configuration Editor.

2 On the Window menu, click System.ini.
3 Locate the section titled [386Enh].
4 Add the following line to the [386Enh] section:

device=vwwsd.386
5 On the File menu, click Exit. 
6 Click Yes to save your changes. 
7 Restart your computer. 

The program is now ready to run.



Important 
Because of changes made to this version of Windows, you cannot quit Martian Memorandum by pressing CTRL+Q.
Instead, quit the program by pressing ALT+SPACE and then clicking Close.



Important 
Because of changes made to this version of Windows, you cannot quit Amazon-Guardians of Eden by pressing 
CTRL+Q. Instead, quit the program by pressing ALT+SPACE and then clicking Close.



Important 
Because of changes made to this version of Windows, you may be unable to run CameraMan for Windows 
version 2.0.
If you are in the United States, call Motion Works at (604) 685-9975, or visit the company’s Web site at 
http://www.motionworks.com for more information about this program. If you are outside the United States, call 
the product support telephone number that came with your copy of CameraMan.



Important 
Because of changes made to this version of Windows, it is recommended that you do not run the Dragon's Lair 
setup program, which copies Dragon's Lair from the CD-ROM to your hard disk. Run the Dragon.exe program 
directly from the CD-ROM instead. You can add a command to start this program to the Start menu or 
Programs menu.
For information about adding a command to the Start or Programs menu, click Start, click Help, and then on 
the Index tab, type Start menu or Programs menu.



Important 
If your computer does not have a math coprocessor, you must run Shadowcaster in MS-DOS mode. If you do not 
know whether your computer has a math coprocessor, save your work in any other programs that are running, 
and then run Shadowcaster. If the game runs correctly, you probably have a math coprocessor and do not need 
to carry out the following procedure. If the game does not run correctly, carry out the following procedure to run 
the game in MS-DOS mode. MS-DOS mode removes Windows from memory and creates an MS-DOS 
environment.

To run Shadowcaster in MS-DOS mode

1 Close the program if it is running, and then use My Computer to locate the program's icon.
2 Right-click the program's icon, and then click Properties.
3 Click the Program tab, and then click Advanced.
4 Select the MS-DOS Mode check box.
5 Click OK in all open dialog boxes, and then restart the program.



Important 
Because of changes made to this version of Windows, you must rename two files before installing TimeActivator. 
If you do not carry out the following procedure, TimeActivator setup may not complete successfully.

To install TimeActivator

1 Click Start, point to Find, and then click Files or Folders. 
2 In the Named box, type the following, and then click Find Now:

odbc*
3 In the folder named Windows\System, locate the files named Odbc.dll and Odbcinst.dll. If the directory that 

contains your Windows files is not named Windows, a different folder name appears instead.
4 Point to the Odbc.dll file, and then click the File menu.
5 Click Rename, and then type the following:

odbc.bak
6 Press ENTER, and then point to the Odbcinst.dll file.
7 On the File menu, click Rename.
8 Type the following, and then press ENTER.

odbcinst.bak
9 Run the setup program for TimeActivator. Installation should complete successfully.



Important
Because of changes made to this version of Windows, Alistair and the Alien Invasion may not install correctly. To 
set up Alistair and the Alien Invasion, carry out the following procedure. This causes your version of Windows to 
report that it is Windows version 3.1 to the setup program.

To enable the setup program for Alistair and the Alien Invasion to run
1 Click here        to start System Configuration Editor.

2 On the Window menu, click Win.ini.
3 Locate the [Compatibility] section.
4 In the [Compatibility] section, type the following text on a line of its own:

DSHELL=0x00200000
5 On the File menu, click Exit.
6 Save your changes made to the Win.ini file by clicking Yes.
7 Click Run Program to continue setting up Alistair Alien Invasion.
8 Carry out steps 1 through 6 again, but for step 4, remove the text you added to the Win.ini file.



Important 
Because of changes made to this version of Windows, you may have problems using Intel Pro Share to capture 
images from 32-bit programs. This is because 16-bit and 32-bit programs run in different contexts. To capture 
images from a 32-bit program, begin by drawing the capture area from inside a 16-bit program. The rectangle 
you draw can include 32-bit programs, but it must begin from a 16-bit program.



Important 
If you are installing audio drivers on your IBM ThinkPad while running this version of Windows, you may need to 
run the installation program twice to install the drivers correctly.



Important 
The sound for Sierra On-Line's Front Page Sports Football Pro '95 does not work correctly under this version of 
Windows unless you run the program in MS-DOS mode. MS-DOS mode removes Windows from memory and 
creates an MS-DOS environment.

To run Front Page Sports Football Pro 95 in MS-DOS mode

1 Close the program if it is running, and then use My Computer to locate the program's icon.
2 Right-click the program's icon, and then click Properties.
3 Click the Program tab, and then click Advanced.
4 Select the MS-DOS Mode check box.
5 Click OK in all open dialog boxes, and then restart the program.



Important 
This game may appear to stop responding after you quit the program. If this is the case, wait for disk activity to 
stop, press ALT+SPACE, and then click Close.
If you are in the United States, contact CUC Software at (800) 757-7707 for more information. If you are outside 
the United States, call the product support telephone number that came with your copy of this game. Or, visit 
the CUC Software Web site at http://www.cucsoftware.com.



Important 
If the PATH statement in your Autoexec.bat file exceeds 128 characters, then Lotus cc:Mail for Windows version 
2.x or earlier cannot run under this version of Windows. To enable earlier versions of cc:Mail to run if your PATH 
statement exceeds 128 characters, carry out the following procedure.

To reduce the length of your PATH statement
1 Click        to start System Configuration Editor.

2 On the Window menu, click Autoexec.bat.
3 Locate the PATH statement. Entries in it are separated by semicolons (;).
4 Delete entries for programs that are no longer installed on your computer or for programs that you rarely 
use.
5 On the File menu, click Exit.
6 Save your changes to the Autoexec.bat file by clicking Yes.
7 Restart your computer, and then run cc:Mail for Windows version 2.0.

If you are in the United States, contact Lotus Development Corporation at (800) 343-5414 for information about 
a version of cc:Mail that was designed for this version of Windows. If you are outside the United States, call the 
product support telephone number that came with your copy of this program. Or, visit the Lotus Web site at 
http://www.lotus.com.



Important 
Because of changes made to this version of Windows, this version of ClickBook may not run. If you use this 
version, your computer may stop responding. 
Call the product support telephone number that came with your copy of ClickBook for information about 
obtaining an upgraded version of the program.



Important 
Because of changes made to this version of Windows, this version of Lightning by Lucid Corp. may not run.
If you are in the United States, contact Lucid Corp. at (800) 967-5550 for more information about this program. If
you are outside the United States, call the product support telephone number that came with your copy of 
Lightning. Or, visit the Lucid Web site at http://www.lucidcorp.com.



Important 
Because of changes made to this version of Windows, the Microsoft Mouse driver version 9.01 installation 
program may not work. To resolve this problem, install the IntelliPoint 1.10 version of the driver.



Important 
Following is a list of known problems and solutions for dBASE version 5.0 running under this version of Windows. 
This information is provided by Borland International. 
Problem Cannot RUN() a program when it is located in a LONG DIRECTORY.
Solution Because dBASE version 5.0 for Windows was designed to work with Windows 3.1, you can work around 
this by referencing the long directory using the eight-letter concatenation that dBASE recognizes. Or, change to 
the appropriate LONG DIRECTORY before using the RUN() function (so a full path is not needed).
Problem Minimizing and maximizing a form kills all events. For example, try Animals.wfm from the Samples 
directory.
Solution dBASE version 5.0 for Windows was designed to work with Windows 3.1. This is a known problem for 
which no workaround exists.
Problem The debugger does not work.
Solution The debugger works correctly if you have set up the appropriate Default.cfg file. dBASE 5.0 for 
Windows was designed to work with Windows 3.1. If you have this problem, call Borland International for a 
program that creates the Default.cfg, or check for this file on the Borland bulletin board.
Problem dBASE becomes unstable after changing the default font for Command Window. This causes the 
"dBASE May Have Become Unstable" message to appear. 
Solution The Command Window Font can be changed, but needs to be done in the Dbasewin.ini file, under the 
CommandWindow section. Following is an example of lines using a 13-point Arial font that can be added to the 
CommandWindow section. Simply add these lines to the Dbasewin.ini file. 

InputPaneFont = Arial, 13
ResultsPaneFont = Arial, 13 

dBASE 5.0 for Windows was designed to work with Windows 3.1.
Problem Right-clicking in Browse on the right edge of the screen causes dBASE to stop responding.
Solution dBASE 5.0 for Windows was designed to work with Windows 3.1. This is a known problem for which no 
workaround currently exists.
For information about obtaining a version of dBASE that supports this version of Windows, contact Borland 
International. You can reach the company in the following ways: telephone (800) 331-0877 or (408) 431-1064; 
BBS (408) 431-5096; Technical Support (408) 461-9123, CompuServe GO Borland. Or, visit the Borland Web site 
at http:/www.borland.com.



Important 
Because of enhancements made to graphics drivers on this version of Windows, this program does not run 
correctly if your screen is set to a resolution other than 640 by 480 pixels. 
For information about changing your screen resolution, click Start, click Help, and then on the Index tab, type 
resolution.



Important 
This version of the Perceive Personal OCR for Hand Scanners software was written for Windows 3.1 and may not 
work correctly under this version of Windows. 
For more information about this program, write to the company at MaxSoft-Ocron, Inc., 4110 Clipper Court, 
Fremont, CA 94538, USA. You can call the company at (800) 933-1399 or visit their Web site at 
http://www.maxsoft-ocron.com.



Important 
Because of changes made to this version of Windows, ExecuVoice by Dragon Systems, Inc., may not work. If you 
use ExecuVoice, it may cause a general protection fault, which may cause Windows to stop responding.
If you are in the United States, contact Dragon Systems, Inc. for more information about this program. You can 
call the company at (800) 825-5897 or (617) 965-5200, or you can visit the company’s Web site at 
http://www.naturalspeech.com. If you are outside the United States, call the product support telephone number 
that came with your copy of this program. Or, visit the Dragon Systems Web site at 
http://www.naturalspeech.com.



Important 
Because of changes made to this version of Windows, At Your Service may not work, and it may cause Windows 
to function incorrectly.
It is recommended that you do not install this program. Microsoft was unable to obtain information about 
upgrades for this program. If no upgrades become available, obtain a similar program that was designed for this 
version of Windows.



Important 
GroupWise Coaches sometimes demonstrate actions by moving the mouse pointer to the menu bar and then 
simulating a mouse click there. If you run GroupWise version 4.1, this action may not work because this version 
of Windows uses a menu font that is different from the font used in previous versions of Windows. The simulated 
mouse click may occur on the wrong menu, causing the Coach to stop. To resolve this problem, carry out the 
following procedure.

To change the font used for menus

1 Click here        to open the Display Properties dialog box.
2 Click the Appearance tab.
3 In the Item list, click Menu.
4 In the Font list, click System.
5 Click OK.



Important 
The Meterwin feature, which is included in LANDesk version 2.0 by Intel, may cause Windows to stop responding.
To resolve this problem, remove the command that starts the program automatically every time you start your 
computer.

To prevent Meterwin.exe from starting automatically
1 Click here        to start System Configuration Editor.

2 On the Window menu, click Win.ini.
3 Locate the [Windows] section.
4 The file name Meterwin.exe may appear in either the Load= or the Run= line. Remove the file name from 
the line in which it appears.
5 On the File menu, click Exit.
6 Save your changes to the Win.ini file by clicking Yes.
7 Restart your computer.



Important 
You cannot use Novell NetWare User Tools with the Microsoft Client for NetWare. Novell NetWare User Tools relies 
on specific dialog boxes to connect to NetWare servers. These dialog boxes are not supported by the Microsoft 
32-bit client for NetWare. If you need to continue to use Novell NetWare User Tools, use the networking software 
that was on your computer before you installed this version of Windows. 
For more information, contact your network administrator.



Important 
Because of changes made to this version of Windows, versions of this setup program that were created before 
1995 may not work correctly. The setup program may not create folders and icons for the main program. To 
resolve this problem, carry out the following procedure.

To create folders and icons for this program

1 Print or write down these instructions.
2 Continue the setup program.
3 After the setup program is finished, restart your computer.
4 Click Start, and then click Run.
5 In the Open box, type the following:

grpconv
6 Click OK.
When the GrpConv program has finished running, click Start, and then point to Programs. A list of several 
submenus should appear, including one named Pilgrim, which was just created. Point to Pilgrim, and then click 
the icon for the program you want to start.



Important 
This version of Microsoft Excel is not fully compatible with this version of Windows. If you use the Print or Print 
Preview commands, Excel may stop responding. 
If you are in the United States, contact Microsoft at (800) 426-9400 for solutions to this problem. If you are 
outside the United States, call the product support telephone number that came with your copy of Excel. Or, visit
the Microsoft Web site at http://www.microsoft.com.



This program may not work correctly under this version of Windows.
For more information about this program, contact its manufacturer or your software vendor.
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This program may not work correctly under this version of Windows.
For more information about this program, contact its manufacturer or your software vendor.



Important 
If you receive a "LINKBUG sees unknown version" message, you have an earlier version of Fortran 77 that needs 
to be upgraded. 
If you are in the United States, contact Absoft for information about obtaining a version of this program that is 
designed for this version of Windows. You can reach the company at (248) 853-0050 or visit their Web site at 
http://www.absoft.com. If you are outside the United States, call the product support telephone number that 
came with your copy of Fortran 77.



Important 
LANDESK version 2.0 and later uses a TSR named Usertsr.exe that may cause this version of Windows to stop 
responding when you use the Microsoft IPX/SPX-compatible protocol (Nwlink.vxd) or file and printer sharing for 
Microsoft Networks (Vserver.vxd). 
A version of the TSR that is designed for this version of Windows is available on Intel's BBS or from Intel product 
support. For the BBS and product support telephone numbers, consult the documentation that came with your 
copy of LANDESK.



Important 
This program may not work correctly under this version of Windows. 
For information about a version of this program that was designed for this version of Windows, contact Traveling 
Software, Inc., at (800) 487-4320 or (425) 483-8088. Or, visit the Traveling Software Web site at 
http://www.travelingsoftware.com.



Important
This program may not run correctly if your taskbar setting is Always On Top. Running this program with the 
taskbar on top may cause problems. If you have problems, carry out the following procedure.

To change your taskbar setting

1 Click Start, point to Settings, and then click Taskbar & Start Menu.
2 Clear the Always On Top check box. 
For more information about this program, contact its manufacturer or your software vendor.



Important
Information about ProShareä products is available on Intel's Web site http://www.intel.com. You can also call 
Intel at (800) 538-3373 or (916) 377-7000.



Important
This setup program created PIF files, which you need to delete before you run the program under this version of 
Windows. Complete the setup program, and then carry out the following procedure.

To delete PIF files created by this setup program

1 Click Start, point to Find, and then click Files or Folders.
2 Click Browse, and then click the plus (+) sign beside the drive on which you installed the program.
3 Click the folder that contains the program, and then click OK.
4 In the Named box, type the following:

*.pif
5 Click Find Now.
6 Click each PIF file that Windows finds, and then press DEL.
7 Start the program you installed. This version of Windows automatically creates a new PIF file that is compatible

with the new Windows environment.



Important
This backup utility was designed for Windows 3.1. Because this version of Windows supports long file names, this
program may not function correctly.
For information about obtaining a version of this utility that was designed for this version of Windows, contact its 
manufacturer or your software vendor.



Important
This version of Central Point Backup was designed for Windows 3.1. Because of changes made to this version of 
Windows, some of this program's features do not function correctly. 
If you are in the United States, contact Symantec Corporation at (800) 441-7234 for information about obtaining 
an upgraded version of this program. If you are outside the United States, call the product support telephone 
number that came with your copy of this program. Or, visit the Symantec Web site at http://www.symantec.com.



Important
Because of changes made to this version of Windows, switching between Navigator version 2.0 and this version 
of Windows is possible only if you obtain a patch from Packard Bell technical support.
For information about obtaining this patch, contact Packard Bell at (800) 598-3000 or (900) 555-3388. Or, visit 
the Packard-Bell Web site at http://www.packardbell.com.



Important
Because of changes made to this version of Windows, QuickBooks versions 2.0 and 3.0 have problems with 
certain functions.
If you use QuickBooks version 2.0 or 3.0 and also use network printers, you will be unable to print to a network 
printer unless the network path is associated with a printer port (this is also referred to as capturing a printer 
port). 
Click here        for information about capturing a printer port.

If you use QuickBooks version 2.0 and want to use this version of Windows, carry out the following procedure.

To change QuickBooks so that it works correctly with this version of Windows
1 Click here        to start the Make Compatible program.

2 On the File menu, click Choose Program.
3 In the Look In list, click My Computer.
4 Double-click the drive that contains the QuickBooks program. QuickBooks is usually on drive C.
5 Locate the folder that contains the QuickBooks program, and then click it.
6 Locate the program icon named QBW, and then click it.
7 In the Make Compatible program, select the Win 3.1 Style Controls check box.

8 On the File menu, click Save, and then click Exit.
For information about obtaining an upgraded version of this program, contact your software vendor. You can also 
visit the Intuit Inc. Web site at http://www.intuit.com.



Important
Microsoft Fortran PowerStation for MS-DOS and Windows is designed to work optimally under Windows 3.1. If you
use Microsoft Fortran PowerStation with this version of Windows, graphics programs that you compiled using the 
program will stop when you run them. A runtime error appears instead of the usual graphics output.
A patch is available to solve this problem. If you are still using version 1.0 instead of 1.0a, you must obtain an 
upgraded version of the program. To determine whether you are using version 1.0a, open the Bin folder, and 
then run Link.exe. If you have version 1.0a, the text "Version 1.0F" should appear. 
To obtain the patch for Microsoft Fortran PowerStation
1 Click Start, and then click Run.
2 In the Open box, type: 

ftp.microsoft.com
3 Click Softlib.
4 Click MSLFILES.
5 Click FPSFIX95.EXE to download this file.



Important
Because of changes made to this version of Windows, this program may not install correctly. You can resolve this 
problem by adding a line to your System.ini file. This causes this version of Windows to report that it is Windows 
version 3.1 to the setup program.

To enable the setup program to run

1 Print or write down these instructions.
2 Click here        to start System Configuration Editor.

3 On the Window menu, click Win.ini.
4 Locate the [Compatibility] section.
5 In the [Compatibility] section, type the following text on a line of its own:

DSHELL=0x00200000
6 On the File menu, click Exit.
7 Save your changes to the Win.ini file by clicking Yes.
8 Restart your computer, and then run the setup program.
9 Carry out steps 2 through 7 again, but for step 5, remove the text you added to the Win.ini file.



Important
Reflection X versions 4.0 and 4.1 do not run under this version of Windows. 
If you are in the United States, contact WRQ customer service for more information about this program. You can 
reach the company by telephone at (206) 217-7100; by fax at (206) 217-0293; and by mail at WRQ, 1500 Dexter
Avenue North, Seattle WA 98109-3051.
If you are outside the United States, contact the company by telephone at 31-70-375-11-00; by fax at 31-70-356-
12-44; and by mail at WRQ Europe, Buitenhof 47, 2513 AH Den Haag, The Netherlands.
You can also visit the WRQ Web site at http://www.wrq.com.



Important
Because of changes made to Windows 95, the Microsoft Mouse Manager or IntelliPoint program files named 
Pointer.exe and Pointer.dll may create error messages when you use the SnapTo feature. To solve this problem, 
update your Pointer.exe and Pointer.dll files.

To update your Pointer.exe and Pointer.dll files

1 Click here        to display the Mouse Properties dialog box.
2 Click the General tab, and then click Change. 

If a Microsoft mouse is already selected, you do not need to carry out the rest of the steps in this procedure. 
However, you may need to carry out the following procedure.

3 Click Show All Devices.
4 In the Manufacturers list, click Microsoft.
5 In the Models list, click the type of mouse you have, and then click OK. 

This copies the upgraded versions of Pointer.exe and Pointer.dll from your Windows Setup disks or CD-ROM to 
your computer.

Notes
File copy errors will occur if your Autoexec.bat file contains a line that specifies an invalid Mouse or Msinput

folder on your hard disk, such as "SET MOUSE=C:\MOUSE" or "SET MSINPUT=C:\MSINPUT." If you receive these 
errors, print or write down these instructions. Then correct the SET MOUSE or SET MSINPUT line in your 
Autoexec.bat file, restart Windows, and repeat the preceding procedure.

If a Microsoft mouse is selected, but you still receive this warning message when the Mouse Manager or 
IntelliPoint features are started, then the new files were not copied to the correct location on your hard disk. To 
correct this, carry out the following procedure.

To replace older files with the new files you just installed

1 Click Start, point to Find, and then click Files Or Folders.
2 In the Named box, type:

pointer.*
3 Click Find Now. 

Two sets of Pointer files will probably appear. The older versions of these files are typically located in folders 
named C:\Mouse, C:\Msinput, or C:\Msmouse. 

4 Copy the Pointer files from your Windows folder to the folder that contains the older versions of the files. This 
will replace the older files.



Important
QualiType FontHandler version 1.0 was designed for Windows 3.1. The functions for installing, uninstalling, and 
grouping TrueType fonts may not work correctly under this version of Windows. However, FontHandler's functions
for viewing installed fonts, printing sample sheets, and installing, uninstalling, and grouping Adobe Type Manager
fonts still work with this version of Windows. 
If you are in the United States, contact QualiType for more information about an upgraded version of 
FontHandler. To order an upgraded version of this program, call (800) 950-2921. For information, call (313) 822-
2921 or send e-mail to QualiType at 74777.3435@compuserve.com. You can also visit the QualiType Web site at 
http://www.qualitype.com.
If you are outside the United States, call the product support telephone number that came with your copy of 
QualiType FontHandler.



Important
When you run the setup program for Microsoft Sound System version 2.0, you will be prompted to replace files 
that are already on your hard disk. Make sure you click No whenever you are prompted to replace existing files. 
If you click Yes, your computer may stop responding, and you may have to reinstall Windows.



Important
Do not use the Cirrus Logic WinMode utility to change display settings in this version of Windows. To adjust your 
screen resolution, color palette, and other settings, click Start, point to Settings, click Control Panel, and then
double-click Display.
You can configure the refresh rate for your display by using the MS-DOS-based Clmode utility. To do this, carry 
out the following procedure.

To configure the refresh rate for your display

1 Print or write down these instructions.
2 Click Start, and then click Shut Down.
3 Click Restart, and then click OK.
4 When the text "Starting Windows" appears, press and release the F8 key.
5 Press 6 to start only a command prompt, and then press ENTER.
6 At the command prompt, type the following:

c:\windows\vgautil\clmode
7 Use the Clmode program to change your refresh rate.
8 Quit the Clmode program, and then restart your computer. 
For an upgraded version of the WinMode program that is compatible with this version of Windows, contact your 
hardware vendor.



Important
Uninstaller 2 was designed for Windows version 3.1 and may not be compatible with this version of Windows. It 
is recommended that you upgrade to the latest version of Uninstaller, which was designed for this version of 
Windows.
For more information, or for support and patches, visit the CyberMedia Web site at http://www.cybermedia.com.



Important
The Norton Rescue Disk utility may not work properly with this version of Windows, because it uses large disk 
support (FAT32). When Setup prompts you to create a Rescue Disk, click No. 
For information about obtaining an upgrade that is compatible with large disk support, contact Symantec 
Corporation at (800) 441-7234 or visit their Web site at http://www.symantec.com. If you are outside the United 
States, call the product support telephone number that came with your Symantec software.



Important
This version of The Norton Utilities does not work properly with this version of Windows, because it uses large 
disk support (FAT32). If you choose to install the program, click No when Setup prompts you to create a Rescue 
Disk. In addition, if you have more than 2 GB of free space on your hard disk, do not install the Norton Protected 
Recycle Bin.
For information about obtaining an upgrade that is compatible with large disk support (FAT32), contact Symantec
Corporation at (800) 441-7234 or visit their Web site at http://www.symantec.com. If you are outside the United 
States, call the product support telephone number that came with your Symantec software.



Important
The Norton Rescue Disk utility does not work properly with this version of Windows, because it uses large disk 
support (FAT32). 
For information about obtaining an upgrade that is compatible with large disk support, contact Symantec 
Corporation at (800) 441-7234 or visit their Web site at http://www.symantec.com. If you are outside the United 
States, call the product support telephone number that came with your Symantec software.



Important
The Norton UnErase feature does not work properly with this version of Windows, because it uses large disk 
support (FAT32). 
For information about obtaining an upgrade that is compatible with large disk support, contact Symantec 
Corporation at (800) 441-7234 or visit their Web site at http://www.symantec.com. If you are outside the United 
States, call the product support telephone number that came with your Symantec software.



Important
The Undo feature of the Norton File Manager does not work properly with this version of Windows, because it 
uses large disk support (FAT32). In addition, the Deleted files tab of the Norton File Manager does not show files
on a FAT32 drive. 
For information about obtaining an upgrade that is compatible with large disk support, contact Symantec 
Corporation at (800) 441-7234 or visit their Web site at http://www.symantec.com. If you are outside the United 
States, call the product support telephone number that came with your Symantec software.



Important 
This version of Speed Disk is unable to optimize drives using large disk support (FAT32). In addition, it is unable 
to optimize the swap file with this version of Windows. 
For information about obtaining an upgrade that is compatible with this version of Windows, contact Symantec 
Corporation at (800) 441-7234 or visit their Web site at http://www.symantec.com. If you are outside the United 
States, call the product support telephone number that came with your Symantec software.



Important
Norton Disk Doctor will not work properly with this version of Windows. Because of changes made to this version 
of Windows, Norton Disk Doctor may incorrectly report errors with the media byte on most hard disks. In 
addition, Disk Doctor will be unable to check any drives that are using large disk support (FAT32). 
For information about obtaining an upgrade that is compatible with this version of Windows, contact Symantec 
Corporation at (800) 441-7234 or or visit their Web site at http://www.symantec.com. If you are outside the 
United States, call the product support telephone number that came with your Symantec software.



Important
This version of the Norton Utilities does not work properly with this version of Windows, because the system uses
large disk support (FAT32). The Disk Image utility is unable to create images of any drives using large disk 
support. Reconfigure Norton System Doctor so that it will not automatically try to create image information for 
these drives. 
In addition, Norton Disk Doctor will be unable to check drives using large disk support (FAT32), and will 
incorrectly report errors on hard disks. Speed Disk will also be unable to optimize drives that use large disk 
support. To remove System Doctor sensors for Image, Disk Integrity, and Fragmentation, right-click each sensor, 
and then click Remove. If you have more than 2 GB of free space on your hard disk, do not enable Norton 
Protection on your Recycle Bin. 
For information about obtaining an upgrade that is compatible with large disk support (FAT32), contact Symantec
Corporation at (800) 441-7234 or or visit their Web site at http://www.symantec.com. If you are outside the 
United States, call the product support telephone number that came with your Symantec software.



Important

This version of F-PROT Professional cannot scan the boot sectors of hard disks using large disk support (FAT32). 
In addition, the progress gauge may reach full capacity too quickly on FAT32 drives. If you attempt to scan a 
FAT32 boot sector for viruses, a warning message will appear. To continue, click OK and the file scan will 
continue normally. To suppress the warning dialog box, you can disable boot sector scanning. To do this, select 
the Scan Hard Drives task in F-PROT Professional, click the Task menu, click Properties, and click to clear the 
Boot Sectors check box.
For more information, contact Command Software Systems.

To contact by Do the following
Mail Send to:

1061 E. Indiantown Road, Suite 500,
Jupiter, FL 33477

Telephone Call (800) 423-9147 (Sales)
Call (561) 575-3200 (Product Support)

Web site Connect to 
http://www.commandcom.com

Important

This version of Dunce may not work properly with this version of Windows.
For information about obtaining an upgraded version of this program, contact Vector Development.

To contact by Do the following
Telephone Call (913) 539-6106
Mail Send to:

Vector Development
P.O. Box 831
Manhattan, KS 66505-0831

E-mail Send to vecdev@cjnetworks.com
Web site Connect to http://www.vecdev.com

Important

This version of PartitionMagic may not function properly on this computer, because the drive is using large disk 
support (FAT32).
For information about obtaining an upgrade that works with FAT32 drives, visit the PowerQuestWeb site at 
http://www.powerquest.com.



Important

This program may not function properly on your computer, because it is using large disk support (FAT32).
For information about obtaining an upgrade that is compatible with FAT32 drives, contact Helix Software 
Company at (800) 451-0551, (408) 988-3832, or their Web site at http://www.helixsoftware.com.



Important

This version of d-Time may not function properly on your computer, because it is using large disk support 
(FAT32).
For information about obtaining an upgrade that is compatible with large disk support, contact Acceleration 
Software.

To contact by Do the following
Telephone Call (360) 598-2456.
E-mail Send to support@accelerationsw.com
Web site Connect to 

http://www.accelerationsw.com

Important

The Dosdata.sys and Dos-up.sys drivers, used during the optimize process of QEMM version 8.0, have minor 
incompatibilities with this version of Windows. Contact Quarterdeck Corporation at (800) 354-3222 for new 
versions of these two drivers or visit their Web site at http://www.quarterdeck.com.
If you are outside the United States, contact Quarterdeck via the methods listed in your QEMM manual.



Important

Installing CleanSweep version 3.04 or earlier over Windows 98 is not recommended. These versions of 
CleanSweep replace some vital system files and may cause Windows 98 and other applications to work 
improperly.
If you must install CleanSweep version 3.04 or earlier, carry out the following procedure:
To install CleanSweep version 3.04 or earlier
1 Find and make backup copies of the following files:

Advapi32.dll
MFC42.dll
Olepro32.dll
Urlmon.dll
Wininet.dll

2 Install CleanSweep, and then restart your computer in MS-DOS mode.
3 Replace the existing .dll files with the backup copies you made in step 1.
4 Restart your computer.

Note
For more information about CleanSweep, contact Quarterdeck Corporation at (800) 354-3222 or visit their 

Web site at http://www.quarterdeck.com.



Important

Do not run the InterLeap 1.1 address bar replacement program with Internet Explorer version 4.0 or later. If you 
do, you will not be able to restart the operating system. Contact the vendor for information about obtaining an 
upgraded version of this program.



Important

Do not install previous versions of Internet Explorer over Internet Explorer version 4.0 or later. Previous versions 
of Internet Explorer will not permit Internet Explorer 4.0 or later to function properly. If you accidentally install a 
previous version of Internet Explorer, uninstall it and then reinstall Internet Explorer 4.0 or later.



Important

NetMeter cannot establish an Internet connection on Windows 98. Contact Starfish Software for information 
about obtaining an upgraded version of this utility. If you are outside the United States, call the product support 
telephone number that came with your Starfish software. Or, visit the Starfish Web site at 
http://www.starfish.com.



Important

Before using PhotoShop version 4.0, download and install PhotoShop Update Version 4.01 from Adobe's Web site,
located at http://www.adobe.com. This upgrade fixes some problems PhotoShop has running on Windows 98.



Important

You are attempting to install Internet Explorer version 5.0 or earlier on Windows 98. Internet Explorer is already 
part of the Windows 98 operating system. Installing an earlier version of Internet Explorer will not allow the 
operating system to function properly.



Important

Some features of NetMeeting 2.0 may not work properly on Windows 98. Specifically, the Application Sharing 
feature is not compatible with the enhancements in Windows 98. Please install and run version 2.1 of NetMeeting
that ships with Windows 98, or a newer version of NetMeeting if available online.



Important

Do not install Microsoft Plus! for Windows 95 over Windows 98. Doing so will corrupt your desktop. Microsoft Plus!
for Windows 95 contains older versions of some files, such as Internet Explorer. The enhancements in Microsoft 
Plus! for Windows 95 have already been incorporated into Windows 98.
If Microsoft Plus! for Windows 95 was already installed before you upgraded to Windows 98, do not uninstall it. 
Uninstalling Microsoft Plus! for Windows 95 will corrupt the operating system.



Important

This product will not run on Windows 98. Contact the product manufacturer for information about obtaining a 
software fix or upgrade.



Important

This product may not function correctly on Windows 98. Contact the product manufacturer for information about 
obtaining a software fix or upgrade.



Important

Some features of this product may not function correctly on Windows 98. Contact the product manufacturer for 
information about obtaining a software fix or upgrade.



Important

If you install Microsoft Money 97 on a computer running Internet Explorer version 4.0 or later, online transactions
will not work. This is because Internet Explorer 4.0 or later uses a newer security model than Microsoft Money 97.
For instructions on upgrading Money so online transactions work, connect to the Microsoft Money Web page at 
http://www.microsoft.com/



Important

This program will not run with Internet Explorer. Contact the program manufacturer for information about 
obtaining a software fix or upgrade.



Important

This program may not function correctly with Internet Explorer version 4.0 or later. Contact the program 
manufacturer for information about obtaining a software fix or upgrade.



Important

Some features of this program may not function correctly with Internet Explorer version 4.0 or later. Contact the 
program manufacturer for information about obtaining a software fix or upgrade.



Important

Do not uninstall Windows 95 Service Pack 1. Doing so will render the Internet Explorer shell inoperable.



Important

If you upgraded from a previous version of Windows, you may need to reconfigure the sound in Aces of the Deep 
version 1.0 if you have a Plug and Play sound card. To reconfigure the sound, please follow the steps below.
1 Identify the interrupts:

a Right click My Computer and select Properties.
b Click the Device Manager tab.
c Click the plus sign (+) next to Sound, video and game controllers.
d Click your sound card.
e Click Properties.
f Click the Resources tab.
g Write down the first Input/Output range, the second Direct Memory Access, and the second Interrupt 

Request (or first Interrupt Request if you have only one).
2 Reconfigure the sound:

a Locate the directory where the game was installed.
b Load soundset.exe and have the application redetect the soundcard. If prompted, enter the settings you 

wrote down in step 1.



Important

Do not install the Windows 95 Service Pack 1 over Windows 98. It was designed for Windows 95. The 
enhancements and fixes included in the Windows 95 Service Pack have already been included in Windows 98. If 
you have upgraded from Windows 95 and already have the Service Pack installed, you should not attempt to 
uninstall it -- it has been incorporated into Windows 98 and you should no longer see it in the add/remove items 
list.



Important

Some features of Norton Navigator may not function correctly with Internet Explorer. If you are in the United 
States, contact Symantec Corporation at (800) 441-7234 for information about obtaining an upgraded version of 
this program. If you are outside the United States, call the product support telephone number that came with 
your copy of this program. Or, visit the Symantec Web site at http://www.symantec.com.



Important

This application may have unpredictable results if used to uninstall Internet Explorer.



Important

Do not install OLEUPD.EXE version 2.1 over Windows 98. Doing so will render the Internet Explorer shell 
inoperable.



Important

Do not install the Windows 95 Service Pack 1 over Windows 98. It was designed for Windows 95. The 
enhancements and fixes included in the Windows 95 Service Pack have already been included in Windows 98. If 
you have upgraded from Windows 95 and already have the Service Pack installed, you should not attempt to 
uninstall it -- it has been incorporated into Windows 98 and you should no longer see it in the add/remove items 
list.



Important

CyberLife Creatures 1.0 is not fully compatible with Internet Explorer version 4.0 or later. You will not be able to 
connect to the Creatures    Web site from within Creatures, nor will all the Creature kits work correctly. Download 
and install Creatures Upgrade Pack 2, located at http://www.cyberlife.co.uk/creatures_frameset.htm. This 
upgrade fixes these problems.



Important

Norton Utilities for Windows 95 was not designed to work on Windows 98 FAT32 drives. Some parts of the 
program will not run as intended. To obtain a current version of Norton Utilities for Windows, call Symantec at 
(800) 441-7234 or visit their Web site at http://www.symantec.com. 



Important

The Microsoft ISDN 1.1 Accelerator Package cannot be installed on this version of Windows. Windows 98 includes 
new dial-up networking features and updated support for all Accelerator Package features. If you are installing an
ISDN device, please verify with your hardware vendor that your ISDN driver is compatible with Windows 98.



Important

You are trying to reinstall Windows on this computer. You cannot do this when Internet Explorer version 4.0 or 
later is installed on your computer. You need to uninstall Internet Explorer 4.0 or later before reinstalling 
Windows.



Important

This version of MSIME is not compatible with Windows 98. Installation will cause system instability after 
rebooting your system. Please use the version of MSIME which ships with this version of the operating system.



Important

This version of Agent 95 or Agent 97 will not run on Windows 98. In the United States contact Connectix 
Corporation at (800) 839-3627. Outside the United States please contact your local Connectix Corporation 
subsidiary.



Important

If you reinstall Service Pack 3 for Windows NT Workstation version 4.0 or Windows NT Server version 4.0 after 
you install Internet Explorer version 4.0 or later, specify, when prompted, that you do not want Service Pack 3 to 
write over any newer files. After Service Pack 3 is reinstalled, update the registry:
1 Click Start, and then click Run.
2 In the Open box, type:

regsvr32 rsabase.dll
3 Click OK.



Important

Running Nuts & Bolts Registry Pro with Internet Explorer may cause an invalid page fault error after you close the
Registry Pro Editor window. For more information or to upgrade your version of Nuts & Bolts Registry Pro, contact 
Helix Software Company at (800) 451-0551 or (408) 988-3832. Or, visit the Helix Web site at 
http://www.helixsoftware.com.



Important

New features in Internet Explorer may cause Nuts & Bolts Trash Guard to work improperly with the Recycle Bin. 
For more information or to upgrade your version of Nuts & Bolts Trash Guard, contact Helix Software Company 
at(800) 451-0551 or (408) 988-3832. Or, visit the Helix Web site at http://www.helixsoftware.com.



Important

You cannot run IBM's Access Aptiva utility when you are using Internet Explorer version 4.0 or later.
This Web site has a compatible version of IBM's Access Aptiva utility and other updated IBM components. You will
need to select the same language that your browser uses.
http://www.us.pc.ibm.com/webcast/ie40/aptiva.html

Note
When clicking this link, you must be logged onto the Internet through your Internet service provider.



Important

Do not install Windows 95 over Windows 98. If you do, neither version of the operating system will be useable. 
You can return to Windows 95 only if you upgraded to Windows 98 from Windows 95 and saved your Windows 95
system files.

To return to Windows 95

1 Click Start, point to Settings, click Control Panel, and then double-click Add/Remove Programs.
2 On the Install/Uninstall tab, click Uninstall Windows 98, and then click OK.

If Uninstall Windows 98 is not on the Install/Uninstall tab, you cannot return to Windows 95.



Important

Because of changes made to this version of Windows, the file Wininet.dll associated with your particular program
is no longer current. You must change the name of the file Wininet.dll so it will not be used by your program.

To rename Wininet.dll
1 In Windows Explorer, locate the folder in which the program is installed.
2 Locate the file Wininet.dll, right-click the file, and then choose Rename.
3 Type any file name that is unique to this folder, for example, Wininet.old.

Make sure that you rename only the file in your program folder. Do not rename the file located in your 
Windows folder.

4 Restart your computer.
If you cannot rename the file using Windows Explorer, perform the following procedure:
1 Print or write down these instructions.
2 Click Start, click Shut Down, and then click Restart in MS-DOS mode.
3 At the MS-DOS prompt, go to the directory in which your application is installed. For example, if the program is

installed in the directory C:\Program Files\MyApp, at the C:\ prompt, you would type:
cd \progra~1\MyApp
and then press ENTER.

4 Type:
ren wininet.dll wininet.old 

and then press ENTER.
5 Restart your computer by pressing CTRL+ALT+DELETE.



Important

The drivers and InControl Tools on this installation CD may cause Windows 98 to malfunction.
Windows 98 includes updated drivers that are installed during setup or when your hardware is detected. 
Windows 98 also includes an updated InControl Tools utility that is compatible with these drivers. This InControl 
Tools utility is intended only as an upgrade to your existing InControl Tools. They will not function without a 
previous installation from your original driver disk or CD-ROM. If you do not already have InControl Tools 
installed, do not follow the instructions below.
If you do have the original InControl Tools installed, upgrade them using these instructions:

To install the Diamond InControl Tools utility provided on your Windows 98 CD

1 Insert your Windows 98 CD into your CD-ROM drive.
2 Click Start, and then click Run. 
3 In the Open box, type the following:

x:\Drivers\Display\Diamond\Disk1\Setup.exe
where x is the letter of your CD-ROM drive.

For newer drivers or a later version of InControl Tools, contact Diamond Technical Support at 541-967-2450, or go
directly to Diamond's web site at http://www.diamondmm.com and navigate to Drivers/Firmware under Support.



Important

Windows has detected that your proprietary DVD player software may be incompatible with the UDF file system. 
Please disable your UDF file system so the CDFS file system can be utilized. 

To disable the UDF file system

1 Click here to start System Configuration Utility.
2 Click Advanced, and then click Disable UDF file system in the Advanced Troubleshooting Settings 

dialog box.
Note

You can also start System Configuration Utility by clicking Start, clicking Run, and then typing msconfig 
in the Open box.



Important

If you put your computer in standby or suspend mode while NetXray is running, NetXray will not function 
properly after restarting your computer.

To turn off suspend mode

1 Click Start, point to Settings, and then click Control Panel.
2 Double-click the Power Management icon.
3 In the Turn off monitor list, select Never.
4 In the Turn off hard disks list, select Never.
5 In the System Standby list, select Never.
If changing the settings does not prevent your computer from going into standby or suspend mode, consult your 
documentation or call the computer manufacturer.
Note

If some or all of these items do not appear in the Power Management control panel, your computer does 
not support the feature.



Important

Nuts & Bolts version 1.03 and earlier will not run on Windows 98. For an updated version, visit the Helix Web site 
at http://www.helixsoftware.com or contact the Helix Software Company at (800) 451-0551 or (408) 988-3832.



Important

The Zip-Rescue portion of this application does not run on Windows 98.
For information about an updated version of this program, visit the Symantec Web site at 
http://www.symantec.com or use Live-Update to check the Symantec FTP site.
If you are in the United States, you can contact Symantec Corporation at (800) 441-7234 or (541) 345-3322. If 
you are outside the United States, call the product support telephone number that came with your copy of this 
program.



Important

Windows 98 directly supports the Microsoft Natural Keyboard and the Microsoft Natural Keyboard Elite, so the 
Intellitype software is not necessary. Only some features, such as Keyboard Sounds, are not provided by 
Windows 98.
If you use Intellitype version 1.0 or 1.0a and enable the "snap-to" feature using the Intellitype Manager or the 
Keyboard control panel applet, the Start menu will not function correctly. To resolve this issue, follow the below 
procedure.
To disable the snap-to feature
1. Press CTRL+ESC to open the Start menu.
2. Press the UP ARROW key to select Settings, press the RIGHT ARROW key to select Control Panel, and then press 

ENTER.
3. Press the arrow keys to select the Keyboard icon, and then press ENTER.
4. Press SHIFT+TAB, and then press the RIGHT ARROW key to select the Pointer Activity tab.
5. Press the TAB key three times, and then press SPACE BAR to clear the Snap pointer to default button in 

dialog boxes check box.
6. Press the TAB key twice, and then press ENTER.
7. Close the Control Panel.
If you want to use Intellitype in Windows 98, please install version 2.2 or later of the Microsoft IntelliPoint 
software. To obtain the latest version of IntelliPoint, contact the Microsoft Order Desk at (800) 360-7561. For 
additional information, visit the Microsoft Web site at http://www.Microsoft.com.



Important

Windows 98 already includes the latest version of The Microsoft Network (MSN). You do not need to use the MSN 
CD to install MSN.
Please remove the MSN CD from your CD-ROM drive. To start MSN Setup, double-click the MSN icon on your 
Windows 98 desktop.
If you would like to redeem any special offers included with your MSN CD, type the REG # (from the CD package 
or accompanying brochure) when prompted. Thank you for choosing MSN!



Important

Some features of Oracle Version 8 may not run correctly in Windows 98. For possible updates, please check the 
Oracle Web site at http://www.oracle.com.
In the United States, Oracle can be contacted at (800) 252-0303 or (650) 506-1500. Outside the United States, 
please contact their local subsidiary.



Important

This version of Reachout is not compatible with Windows 98 and will not run correctly. For information about 
program updates and known issues, visit the Stac International Web sites at http://www.stac.com and 
http://support.stac.com, or contact Stac Product Support at (800) 305-7822 or (619) 794-3700.



Important

Novaback+ version 5.0 is not compatible with Windows 98. For information about compatibility problems, 
program updates, or possible workarounds for this version, visit the NovaStor Web site at 
http://www.novastor.com or call (805) 579-6700.



Important

Mango Medley 97 is compatible with Windows 98. However, Medley 97 installs an older version of the file 
Cfgmgr32.dll, which could cause the following error after you restart your computer:
"RUNDLL. Error loading Powrprof.dll. A device attached to the system is not functioning."
To eliminate this error, take the following steps after you install Medley 97:
1. On the taskbar, click Start, click Run, and then type SFC.EXE to start the System File Checker.
2. In the System File Checker dialog box, make sure the Scan files for errors button is selected, and then click 

Start.
3. If Cfgmgr32.dll and Imagehlp.dll are shown to have been replaced by older versions, use the Windows 98 CD-

ROM to restore both files to your \Windows\System directory.
4. Restart your computer.
A new release of Mango Medley, Mango Medley 98, is available. For more information, visit the Mangosoft 
Coporation Web site at http://www.mango.com or call (800) 698-2129 or (970) 522-1582.



Important

This version of Defiance is not compatible with Windows 98. Updates that provide Windows 98 compatibility and 
enhanced Force Feedback Joystick support are available from the program manufacturer. For more information, 
visit the Avalon Hill Games Web site at http://www.avalonhill.com or call (410) 426-9600.



Important

You cannot play this version of VRSports Virtual Pool 2 in Windows 98 using color settings greater than 256. An 
update is available from the program manufacturer that will allow you to play in full 16-bit color resolution. To 
play using 8-bit color, you must change your Windows resolution to 256 colors before starting the game. For 
information on changing color resolution, type colors on the Windows Help Index tab.
Note
If you use the in-game menus to change to more than 256 colors, the game may exit with an error message 
stating that you must reinstall Virtual Pool 2. However, you do not need to reinstall. Restart the game and you 
should be able to continue at the resolution you were using before you made the change.
For information about updates to this version of Virtual Pool 2, visit the VRSports Web site at 
http://www.vrsports.com or call (714) 553-6678.



Important

When you install Microsoft Bookshelf 1996-1997, you have the option of installing Microsoft Internet Explorer 
version 2.0. However, Windows 98 contains Internet Explorer version 5.0. If you install version 2.0, some of the 
features of Internet Explorer 5.0 may not work correctly.
When you install Microsoft Bookshelf 1996-1997, if you choose the Custom install option, make sure you do not 
select Internet Explorer or the Select All option. If you choose the Typical install option, Internet Explorer 2.0 
will not be installed.



Important

You are trying to install a version of Windows 98 that is earlier than the version currently installed.
You can return to the earlier version only if you upgraded from that version to the currently installed version and 
saved your Windows system files.
To return to an earlier version of Windows 98
1. Click Start, point to Settings, click Control Panel, and then double-click Add/Remove Programs.
2. On the Install/Uninstall tab, click Uninstall Windows 98, and then click OK.
If Uninstall Windows 98 does not appear on the Install/Uninstall tab, you cannot return to the earlier version
of Windows 98.



Important

Do not install this program with this version of Windows. The program is older than the version included with 
Windows. You should either obtain an upgraded version of the program, or install the version included with 
Windows.
To install the program included with Windows
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click Add/Remove Programs, and then click the Windows Setup tab.
3. Follow the instructions on the tab.



Upgrade to Windows 2000

Windows 2000 contains an earlier version of Internet Explorer components. Please uninstall Internet Explorer 5.5 
before proceeding with the upgrade. Once Windows 2000 is installed, you can update the Internet Explorer 
components by installing Internet Explorer 5.5 again.



Important

Do not install this hardware driver with this version of Windows. The driver is older than the version included with
Windows. You should either obtain an upgraded version of the driver, or install the version included with 
Windows.
To install the driver included with Windows
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click Add New Hardware.
3. Follow the instructions on your screen.



Upgrade to Windows 2000

Please download the Windows 2000 upgrade pack for Internet Explorer 5.5 before upgrading to Windows 2000. 
You can download the upgrade pack by running Internet Explorer 5.5 setup and select custom, or visit 
http://windowsupdate.microsoft.com 



Upgrade to Windows 2000

Upgrading to Windows 2000 will install Internet Explorer 5.01 on your machine. You will need to reinstall Internet 
Explorer 5.5. to upgrade your browser.




